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INTRODUCTION 

Computer networks are used in all areas of human life: for education, 

communication, purchase of goods and services, recreation, remote work, control of 

intelligent devices of smart houses and city infrastructure devices, control of 

agricultural devices for soil condition monitoring, automatic watering of plants 

depending on environmental conditions and making managerial decisions in business. 

To manage smart devices, IT specialists must know not only programming 

technologies, but also data transmission technologies over the network, the principles 

of computer networks and their components, network applications, and the specifics of 

using network protocols for various applied tasks.  

The discipline "Computer Systems and Networks Fundamentals" is part the of 

professionally-oriented disciplines cycle for bachelors of the speciality 121 “Software 

Engineering”. 

This tutorial is developed for familiarizing students with theory and practical 

methods of computer systems and networks and requirements for laboratory works. 

The purpose of the tutorial is to gain skills in creation and configuration of a local 

area network, configuration of network devices, IP addressing, checking the quality 

and security of network communications. Students also gain skills in Packet Tracer 

network simulation environment and Wireshark – the widely-used network protocol 

analyzer. The tutorial includes the introduction and 4 sections devoted to a certain 

laboratory work. There are a work objective, a description of the task, theoretical 

information and methodological instructions for every laboratory task; questions for 

self-assessment and a list of recommended literature. 

 The tutorial is aimed at students of the educational program “Software 

Engineering of Multimedia and Information Retrieval Systems” of the Faculty of 

Applied Mathematics of Igor Sikorsky Kyiv Polytechnic Institute. 
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LABORATORY WORK № 1. NETWORK DEVICES AND 

COMMUNICATIONS. PACKET TRACER SIMULATION ENVIRONMENT 

Objective: to get acquainted with the main network devices and tools of data 

transmission of computer networks using the simulation environment Packet Tracer, 

learn how to add new devices to the simulator, make connections, configure nodes and 

test connections. 

Theory and methodological instructions 

Network Components 

Network infrastructure contains three categories of network components: 

 Devices;  

 Media; 

 Services. 

End Devices 

An end device is where a message originates from or where it is received. Data 

originates with an end device, flows through the network, and arrives at an end device. 

 

Intermediary Network Devices 

An intermediary device interconnects end devices in a network.  Examples are:  

switches, wireless access points, routers, and firewalls. 

 

Network Media 

Тypes: 

 Metallic wires within cables, such as copper. 

 Glass, such as fiber optic cables. 

 Wireless transmission. 

Twisted-Pair is a type of copper cable. TP is the most common type of  network 

cabling. 

Coaxial Cable is usually made of copper or aluminum. It is used by cable 

television companies to provide service, and for satellite communication systems. 
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Fiber-optic cables are made of glass or plastic. They have a very high bandwidth,  

so they can carry vast amounts of data. Fiber-optic is used in backbone networks, large 

enterprise environments, and large data centers. 

Twisted pair, coaxial cable and fiber optic lines are most often used as tools of 

communication. When choosing the type of cable take into account the following 

indicators: 

 Cost of installation and service; 

 Speed of information transfer; 

 Restrictions on the amount of information transmission distance; 

 Data security. 

The main problem in the design computer networks are simultaneously providing 

these indicators. For example, the highest data rate is limited to the maximum possible 

data transmission distance, while still providing the required level of data protection. 

The expansion of the cable system affects its cost and security of data transmission. 

Submarine communications cable 

A submarine communications cable is a cable laid on the sea bed between land-

based stations to carry telecommunication signals across stretches of ocean and sea 

(Fig.1.1.) [1]. 

 

Fig.1.1. Submarine Cable Map 
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 The first submarine communications cables laid beginning in the 1850s carried 

telegraphy traffic, establishing the first instant telecommunications links between 

continents, such as the first transatlantic telegraph cable which became operational on 

16 August 1858. Subsequent generations of cables carried telephone traffic, then data 

communications traffic. Modern cables use optical fibre technology to carry digital 

data, which includes telephone, Internet and private data traffic. 

Modern cables are typically about 25 mm in diameter and weigh around 1.4 

tonnes per kilometre (2.5 short tons per mile; 2.2 long tons per mile) for the deep-sea 

sections which comprise the majority of the run, although larger and heavier cables are 

used for shallow-water sections near shore. Submarine cables first connected all the 

world's continents (except Antarctica) when Java was connected to Darwin, Northern 

Territory, Australia, in 1871 in anticipation of the completion of the Australian 

Overland Telegraph Line in 1872 connecting to Adelaide, South Australia and thence 

to the rest of Australia. For planning and installing cables in the ocean, we need a lot 

of technology, effort and money (Fig.1.2). 

   

 

Fig.1.2. Сable Іnnovator (carries up to 8500 cables and lays it under water) [2] 
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Networks of Many Sizes 

 Small Home Networks – connect a few computers to each other and the 

Internet. 

 Small Office/Home Office – enables computer within a home or remote 

office to connect to a corporate network. 

 Medium to Large Networks – many locations with hundreds or thousands 

of interconnected computers. 

 World Wide Networks – connects hundreds of millions of computers world-

wide – such as the Internet. 

Clients and Servers 

Servers are computers that provide information to end devices on the network.  

For example, email servers, web servers, or file server 

Clients are computers that send requests to the servers to retrieve information 

such as a web page from a web server or email from an email server. 

   Client and server software usually run on separate computers. 

Peer-to-Peer 

Each device (known as a peer) can function as both a server and a client. These 

networks are called peer-to-peer networks. 

Peer-to-peer networking advantages: easy to set up, less complex, and lower cost. 

Disadvantages:  no centralized administration, not as secure, not scalable, and 

slower performance. 

Common P2P networks include: 

 G2; 

 Bitcoin; 

 BitTorrent; 

 eDonkey. 

Some P2P applications are based on the Gnutella protocol, where each user shares 

whole files with other users. Many P2P applications allow users to share pieces of 

many files with each other at the same time – this is BitTorrent technology. 
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Types of networks 

Local Area Network (LAN) – spans a small geographic area owned or operated 

by an individual or IT department. Spans a small geographic area such as a home, 

school, office building, or campus. Usually administered by a single organization or 

individual. Provides high speed bandwidth to end and intermediary devices within the 

network. 

Wide Area Network (WAN) – spans a large geographic area typically involving 

a telecommunications service provider. WANs interconnect LANs over wide 

geographical areas such as between cities, states, or countries. Usually administered by 

multiple service providers. 

WANs typically provide slower speed links between LANs. 

Other types of networks: 

 Metropolitan Area Network (MAN). 

 Wireless LAN (WLAN). 

 Storage Area Network (SAN). 

 

The Internet 

The Internet is a worldwide collection of interconnected LANs and WANs. 

LANs are connected to each other using WANs. WANs are then connected to each 

other using copper wires, fiber optic cables, and wireless transmissions. 

 

Data Centers 

Cloud computing is possible thanks to Data Centers. Data center is a building in 

which computer systems and components are located, such as: 

 Сonnecting cables for data transmission. 

 High-speed virtual servers (clusters). 

 Backup data storage systems. 

 Reserve power. 

 Aair conditioning systems. 

 Safety devices. 
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The data center can be one room in the building, one or several floors or the 

entire building. Modern data centers are used for cloud computing and virtualization to 

effectively process large amounts of data. Data centers are usually expensive to create 

and maintain (Fig. 1.3). 

 

Fig.1.3. Data center example. 

Network Security Solutions 

Network security components for home or small office network: 

 Antivirus software. 

 Firewall filtering. 

     Larger networks have additional security requirements: 

 Dedicated firewall system to provide more advanced firewall capabilities. 

 Access control lists (ACL) – used to filter access and traffic forwarding. 

 Virtual private networks (VPN) – used to provide secure access for 

remote workers. 

Network Protocols 

Networking protocols define a common format and set of rules for exchanging 

messages between devices. Some common networking protocols are Hypertext 

Transfer Protocol (HTTP), Transmission Control Protocol (TCP), and Internet 

Protocol (IP). 
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Internet Standards 

 Internet Society (ISOC) – promotes open development and evolution of 

Internet use globally. 

 Internet Architecture Board (IAB) – management and development of 

Internet standards.  

 Internet Engineering Task Force (IETF) – develops, updates, and maintains 

Internet and TCP/IP technologies.  

Internet Corporation for Assigned Names and Numbers (ICANN) – 

coordinates IP address allocation and management of domain names. 

Internet Assigned Numbers Authority (IANA) – manages IP address 

allocation, domain name management, and protocol identifiers for ICANN. 

Internet Research Task Force (IRTF) – focused on long-term research related 

to Internet and TCP/IP protocols. 

OSI model 

The Open Systems Interconnection (OSI) model describes seven layers that 

computer systems use to communicate over a network (Table 1.1). 

Table 1.1. OSI Layer Description 

OSI Layer OSI Layer Description 

7. Application contains protocols used for process-to-process 

communications. 

 6. Presentation provides for common representation of the data. 

     5. Session provides services to the presentation layer to organize its 

dialogue and to manage data exchange. 

4. Transport defines services to segment, transfer, and reassemble the data. 

3. Network provides services to exchange the individual pieces of data 

over the network between identified end devices. 

2. Data Link provides methods for exchanging data frames between devices 

over a common media. 

1. Physical describes the mechanical, electrical, functional, and procedural 

means to transmit bits across physical connections. 
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IP Addressing 

Each end device on a network (e.g., PCs, laptops, servers, printers, VoIP phones, 

security cameras) require an IP configuration consisting of: 

 IP address. 

 Subnet mask. 

 Default gateway. 

Interface Addressing Verification 

The IP configuration on a Windows host is verified using the ipconfig command. 

To verify the interfaces and address settings of intermediary devices like switches 

and routers, use the show ip interface brief privileged command. 

End-to-End Connectivity Test 

The ping command can be used to test connectivity to another device on the 

network or a website on the Internet. The ping command is an IPv4 and IPv6 testing 

utility that uses ICMP echo request and echo reply messages to test connectivity 

between hosts and provides a summary that includes the success rate and average 

round-trip time to the destination.  

If a reply is not received within the timeout, ping provides a message indicating 

that a response was not received. It is common for the first ping to timeout if address 

resolution (ARP or ND) needs to be performed before sending the ICMP Echo 

Request. 

Ping the Loopback 

Ping can be used to test the internal configuration of IPv4 or IPv6 on the local 

host. To do this, ping the local loopback address of 127.0.0.1 for IPv4 (::1 for IPv6). 

A response from 127.0.0.1 for IPv4, or ::1 for IPv6, indicates that IP is properly 

installed on the host.  
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Ping the Default Gateway 

The ping command can be used to test the ability of a host to communicate on the 

local network.  The default gateway address is most often used because the router is 

normally always operational. A successful ping to the default gateway indicates that 

the host and the router interface serving as the default gateway are both operational on 

the local network. If the default gateway address does not respond, a ping can be sent 

to the IP address of another host on the local network that is known to be operational. 

 

Fig.1.4. Ping the Default Gateway. 

Ping a Remote Host 

Ping can also be used to test the ability of a local host to communicate across an 

internetwork. A local host can ping a host on a remote network. A  

successful ping across the internetwork confirms communication on the local network. 

Many network administrators limit or prohibit the entry of ICMP messages therefore, 

the lack of a ping response could be due to security restrictions. 
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Network devices 

Networks card, network adapter, Ethernet adapter, NIC (network interface card ) 

is responsible for the transfer of information between network units. Any network card 

consists of a connector for a network conductor and a microprocessor that encodes / 

decodes network packets and from auxiliary software and hardware complexes and 

services. Each network card has its own physical MAC address (Media Access 

Control) – a unique identifier of the device. 

 This is an identifier that is compared to different types of equipment for 

computer networks. In the case of Ethernet networks, this is a unique identifier 

(number) of the network card. MAC address format –  6 pairs of numbers and letters, 

usually separated by a hyphen or a colon. For example: 00: 1D: 72: 1F: AC: 95 or: 

00-3D-42-3F-SC-95 . 

 

 Fig.1.5. Network card 

Network environment 

Modern networks use mainly three types of environments that connect devices 

and provide the path through which data is transmitted. These types of environments 

include: 

• metal wires inside the cable;  

• glass or plastic fibers (fiber optic cable); 

• radio communication.  
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The encoding of the signal required for transmission is different depending on the 

type of medium. 

In metal wires, the data is encoded in the form of electrical pulses that 

correspond to certain patterns. 

Transmission in fiber-optic networks occurs in the form of light pulses, in the 

range of infrared radiation or visible light. 

In wireless transmission, electromagnetic radiation patterns are used to 

describe different bit values. 

Copper cables 

There are three main types of copper cables in network technologies: 

• coaxial cable; 

• unshielded twisted pair (UTP);  

• shielded twisted pair (STP).  

These cables are used to connect LAN nodes and network infrastructure devices 

such as switches, routers, and wireless access points. Each type of connection and the 

corresponding devices have certain requirements for cables provided by physical level 

standards. 

Coaxial cable 

Coaxial cable has an average price, is well noise-proof and is used for long-

distance communication (several kilometers). A coaxial cable is so named because the 

two conductors in it use the same axis. 

Coaxial cable consists of the following elements: 

• copper conductor for transmission of electrical signals; 

• copper conductor surrounded by elastic plastic insulation; 

• insulating material surrounded by copper braid or metal foil. 

This screen reduces the number of external electromagnetic interference.  

The entire cable is covered with a cable sheath to protect against minor physical 

damage. 
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Fig.1.6. Coaxial cable 

The data transfer rate is from 1 to 10 Mbit / s, in some cases up to 50 Mbit / s. 

Coaxial cable is used for basic and broadband information transmission. 

 

 

 

Twisted pair 

The cheapest cable connection is a twisted twisted pair wire connection. Supports 

data transmission at a distance of up to 100 meters. At long distances the signal is not 

recognized due to attenuation; if long-distance data transmission is still required, you 

have to use a repeater, or use a coaxial cable. The advantages are low price and 

trouble-free installation. 

Unshielded twisted pair consists of eight wires. Each wire is insulated 

separately; all eight wires are assembled in four twisted pairs. Curling wires prevents 

cross-barriers caused by adjacent pairs and external sources. All four pairs are placed 

in a common shell. 

                                    

a) unshielded twisted pair (UTP);       b) shielded twisted pair (STP) 

Fig.1. 7. Twisted pair 

Shielded twisted pair is often used, ie twisted pair placed in a shielding sheath, 

similar to a coaxial cable shield. This increases the cost of twisted pair and brings its 

price closer to the price of coaxial cable. 

https://uk.wikipedia.org/wiki/%D0%9C%D0%B5%D1%82%D1%80
https://uk.wikipedia.org/wiki/%D0%97%D0%B0%D0%B3%D0%B0%D1%81%D0%B0%D0%BD%D0%BD%D1%8F
https://uk.wikipedia.org/wiki/%D0%9F%D0%BE%D0%B2%D1%82%D0%BE%D1%80%D1%8E%D0%B2%D0%B0%D1%87
https://uk.wikipedia.org/wiki/%D0%9A%D0%BE%D0%B0%D0%BA%D1%81%D1%96%D0%B0%D0%BB%D1%8C%D0%BD%D0%B8%D0%B9_%D0%BA%D0%B0%D0%B1%D0%B5%D0%BB%D1%8C
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Twisted pair has supplanted coaxial cable due to several obvious advantages. The 

twisted pair cable consists of eight separate wires, which makes it more flexible than 

coaxial and, accordingly, facilitates its laying. The minimum set of equipment for a 

twisted -pair network includes the following elements: 

 network adapters (by the number of computers connected to the network);  

 UTP connectors RJ-45; 

 cable segments with RJ-45 connectors at both ends (according to the number of 

computers connected); 

 switch that has as many UTP ports with RJ-45 connectors as you have to 

connect computers. 

Cable categories 

There are several categories of twisted pair cable, which are numbered from CAT 

1 to CAT 8.2 . A higher category cable usually contains more pairs of wires and each 

pair has more turns per unit length. 

Categories of unshielded twisted pair are described in EIA / TIA 568 .  

 

Fiber optic lines 

The most expensive are fiber optics, or fiberglass cables. 

 

 Fig. 1. 8. Fiber Optic 

Permissible distance of more than 50 km. External action of obstacles is 

practically absent. This is currently the most expensive connection. It is used where 

there are electromagnetic interference fields or the need to transmit information over 

very long distances without the use of repeaters. They have anti-eavesdropping 

properties, as the technique of branches in fiber optic cables is very complex.  

https://uk.wikipedia.org/wiki/%D0%94%D1%80%D1%96%D1%82
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The transmission of information is via two fiber-optic cables that transmit signals 

in different directions. Sometimes two-wire fiber-optic cables containing two cables 

are used in a common outer sheath, but more often two single cables. 

 Contrary to popular belief, the cost of fiber optic cable is not very high (it is 

close to the cost of thin coaxial cable). However, in general, the equipment in this case 

is significantly more expensive, as it requires the use of expensive fiber-optic 

transceivers. 

The main advantages of data transmission over fiber-optic communication lines 

are: 

 High data rate –  3GHz, while for copper cable this value is not more than 500 

MHz. 

 Insensitivity to electromagnetic interference .  

 Absence of electromagnetic radiation during data transmission .  

 Providing galvanic isolation between transmitter and receiver.  

Fiber optic cable consists of the following components: optical fiber, optical 

shield, protective shield. 

Own transmission medium –  optical fiber is a glass or plastic core, the thickness 

of which, depending on the purpose of the cable can vary from units to hundreds of 

microns. 

Cables with a fiber diameter of 10 microns are called single-mode by the name of 

the radiation mode of the transmitting element – the laser. Cables with a fiber diameter 

of 60 microns or more are called multimode. 

Single mode fiber optic cables ( Single Mode Fiber – SMF ) are more difficult to 

manufacture and operate, however, they are able to provide a long range of 

information signal. Cheaper in manufacture and more convenient in operation 

multimode (Multi Mode Fiber – MMF) cables provide a shorter range of information 

signal. 
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Features of wireless environment 

With the help of ultra-high frequencies, wireless data carriers transmit 

electromagnetic signals that represent bits of transmitted information. 

Unlike copper and fiber optic cables, wireless network as a network environment 

is not limited to conductors. Wireless data transmission medium is characterized by the 

greatest mobility. The number of wireless devices is constantly growing. That's why 

wireless networking has become an environment for home networks. Also, the 

popularity of wireless networks is growing rapidly due to the growing bandwidth of 

the network. 

However, the wireless network has some problem areas: 

• Coverage area. Wireless data technologies work well in open spaces. However, 

some structural materials used in buildings as well as terrain conditions may limit the 

coverage area. 

• Obstacles. The wireless network is susceptible to cross-interference, and its 

operation may be impaired by conventional devices, such as cordless telephones, 

television receivers, certain types of fluorescent lamps, microwave ovens, and other 

wireless communications. 

• Security. Wireless coverage is not limited to terms of access to the 

environment. Therefore, unauthorized users and devices can access the transfer. 

Therefore, network security tools are a key component of wireless network 

administration. 

Three data transmission standards apply to wireless networks. 

IEEE 802.11 Standard: Wireless Local Area Network (WLAN) technology, 

commonly referred to as Wi-Fi, uses a competing or non-deterministic multiple access 

system (CSMA / CA). 

IEEE 802.15 standard: a wireless personal area network standard known as 

Bluetooth; for data transmission at distances from 1 to 100 meters requires a close 

location of two devices. 

IEEE 802.16 standard: known as the Broadband Radio Protocol (WiMAX); 

uses a point-to-point topology to provide wireless broadband access. 
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Although the popularity of wireless desktops is growing, copper and fiber optic 

cables are the most popular networking environment on the physical layer. There are a 

number of principles for building networks based on the components discussed above. 

Such principles are also called topologies. 

 

Topologies of computer networks 

Star topology 

This is the apology of a network with a clearly defined center to which all other 

subscribers are connected. The exchange of information is exclusively through the 

central computer, which bears a greater load, so nothing but the network, he usually 

can not do. The network of central subscriber equipment must be significantly more 

complex than the equipment of peripheral subscribers. The central computer is the 

most powerful, it is entrusted with all the functions of exchange management. No 

conflicts in the network with the " star " topology are in principle possible, because the 

control is completely centralized. 

If we talk about the resilience of the star to computer failures, the failure of the 

peripheral computer or its network equipment does not affect the functioning of the 

network, but any failure of the central computer makes the network completely 

inoperable. In this regard, special measures should be taken to increase the reliability 

of the central computer and its network equipment . 

Network bandwidth is determined by the computing power of the node and is 

guaranteed for each workstation. Data collisions do not occur. 

The cable connection is quite simple, as each workstation is connected to a node. 

The cost of laying cables is high, especially when the central node is not 

geographically located in the center of the topology. 

When expanding network , previously made cable connections cannot be used: a 

separate cable from the network center must be laid to the new workstation. 
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Fig. 1.9. Star topology 

Star topology is the fastest of all topologies and computer networks , because the 

transmission of data between workstations passes through a central node (with its good 

performance) on individual lines used only by these workstations. The frequency of 

requests for information transfer from one station to another is low compared to that 

achieved in other topologists . 

Central control node – the file server implements the optimal mechanism of 

protection against unauthorized access to information. The entire network can be 

managed from its center. 

Ring topology 

In a ring network topology, the workstations are connected to each other in a 

circle, ie workstation 1 with workstation 2, workstation 3 with workstation 4, and so 

on. The last workstation is connected to the first. The communication link is closed in 

a ring. Laying cables from one workstation to another can be quite complex and 

expensive, especially if the geographical location of the workstations is far from the 

shape of the ring (for example, a line). 

 

Fig. 1.10. Ring topology  

Messages circulate regularly in a circle . The workstation sends information to a 

specific destination address, having received a request from the ring in advance. 
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Sending messages is very efficient, as most messages can be sent over the cable 

system one by one. It is very easy to make a ring request to all stations. The duration 

of information transfer increases in proportion to the number of workstations included 

in the computer network. 

The main problem with the ring topology is that each workstation must be 

actively involved in sending information, and in the event of failure of at least one of 

them, the entire network does not work . Connecting a new workstation requires a 

short emergency shutdown, as the ring must be open during installation. There is no 

limit to the length of the computer network, as it is determined solely by the distance 

between the two workstations. 

Bus topology 

In a bus topology, the information transmission medium is presented in the form 

of a communication path, accessible to all workstations to which they must all be 

connected. All workstations can come into direct contact with any workstation 

available on the network. 

 

Fig. 1.11. Bus topology 

Workstations can be connected to or disconnected at any time without 

interrupting the entire network. The operation of the network does not depend on the 

state of the individual workstation. Due to the fact that workstations can be connected 

without interrupting network processes and communication environment, it is very 

easy to listen to information. 

The main characteristics of the three most typical network topologies data 

transfers are shown in table 1.2. 

 



23 

 

Table 1.2. Basic characteristics of computer network topologies 

FEATURES 
NETWORK TOPOLOGIES  

Star Ring Bus 

The cost of expansion Insignificant Average Average 

Connecting subscribers Passive Active Passive 

Failure protection Insignificant Insignificant High 

System size Arbitrary Arbitrary Limited 

Eavesdropping 

protection 

 

Good Good Insignificant 

Connection cost Insignificant Insignificant High 

Behavior of the system at 

high loads 
Good Satisfactory Bad 

Ability to work in real 

time 
Very good Good Bad 

Cable distribution Good Satisfactory Good 

Service Very good Average Average 

 

Tree topology 

The combined or tree-like structure is formed in the form of combinations of the 

above – mentioned topologies of computer networks. The base of the network tree 

(root) is located at the point where the communication lines of information (tree 

branches) gather. 

 

      Fig. 1.12. Tree structure of the network  
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Networks with a tree structure are used where the direct use of basic network 

structures in its pure form is not possible. Network amplifiers and switches are used to 

connect a large number of workstations in accordance with adapter boards. 

Packet Tracer simulation environment  

Cisco Packet Tracer allows to create network topologies from a wide range of 

routers and switches, workstations and network connections such as Ethernet , Serial , 

ISDN . This function can be performed for both training and work, for example, to 

perform network settings at the planning stage or to create a copy of the working 

network to troubleshoot. To run Packet Tracer needs to run the executable file 

PacketTracer.exe. The general view of the program is shown in Fig.1.13. 

 

Fig.1. 13. Cisco Packet Tracer simulation environment 
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The working area of the program window consists of the following elements: 

1. Menu Bar –  a panel that contains the menu File, Edit, Options, View, Tools, 

Extensions, Help. 

2. The Main Tool Bar contains graphic images of shortcuts to access the menu 

commands File, Edit, View and Tools as well also Network Information button. 

3. Common Tools Bar is a panel that provides access to the most used tools of 

the program: Select, Move Layout, Place Note, Delete, Inspect, Add Simple PDU and 

Add Complex PDU. 

4. Logical / Physical Workspace and Navigation Bar –  a panel that gives 

possibility switch working area : physical or logical , and also allows move between 

levels cluster . 

5. Workspace – the area in which the network is created, simulation 

observations are carried out, various information and statistics are visible. 

6. Realtime / Simulation Bar – Use the tabs in this panel to switch between 

Realtime mode and Simulation mode. It also contains Power Cycle Devices buttons, 

Play Control buttons and an Event List switch in Simulation mode. 

7. Network Component Box – the area in which devices and connections are 

selected to place them on the workspace. She contains Device area –  Type Selection 

and Device area –  Specific Selection. 

8. Device - Type Selection Box – area contains available types devices and 

connections in Packet Tracer. The Device – Specific Selection area changes depending 

from selected device . 

9. Device - Specific Selection Box – an area used to select specific devices and 

connections needed to build in the network workspace. 

10. User Created Packet Window – this window manages packets that were 

created on the network during the simulation of the script. 

To create a topology, we have to select a device from the Network Component 

panel, and then select the type of the selected device from the Device - Type 

Selection panel.  
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Then we have to click the left mouse button in the field of the workspace of the 

program (Workspace). We can also move the device directly from the Device - Type 

Selection area, but the default device model will be selected. 

To quickly create multiple instances of the same device, hold down the Ctrl key, 

click on the device in the Device – Specific Selection area, and release the Ctrl key. 

You can then tap the workspace several times to add copies of the device. 

Network evices are presented in Packet Tracer: 

 routers; 

 switches; 

 end devices – PCs, servers, printers, IP phones; 

 wireless devices: access points and wireless routers; 

 other devices – cloud, DSL modem and cable modem, etc. 

Add the necessary elements to the work area of the program as shown in              

Fig.1. 14. 

 

Fig.1. 14. Adding network elements 
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 When adding each element, the user has the opportunity to give it a name and 

set the necessary parameters. To do this, left-click on the desired item and go to the 

Config tab in the device dialog box. 

 The properties dialog box for each item has two tabs: Physical – contains the 

graphical interface of the device and allows to simulate working with it on a physical 

level. Config –  contains all the necessary parameters for configuring the device and 

has a user-friendly interface. 

Depending on the device, the properties may have an additional tab to control the 

operation of the selected item: Desktop (if the end device is selected) or CLI (if a 

router is selected) and so on. Use the Delete (Del) button to remove unwanted devices 

from the application workspace. We will connect the added elements with the help of 

connecting links. To do this, select the Connections tab from the Network panel 

Component Box . We will see all possible types of connections between devices. 

Select the appropriate cable type. The mouse pointer changes to the "connection" 

cursor. Click on the first device and select the appropriate interface to which you want 

to connect, and then click on the second device, performing the same operation. You 

can also connect using Automatically Choose Connection Type (automatically 

connects elements in the network). Select and click on each of the devices to be 

connected. A cable connection will appear between the devices, and the indicators at 

each end will show the connection status (for interfaces that have an indicator). 

 

Fig. 1.15. Types of cables supported in Packet Tracer 

Packet Tracer supports a wide range of network connections (see Table 1.3). Each 

cable type can only be connected to certain types of interfaces. 
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Table 1.3. Connection types in Packet Tracer 

Cable type Description 

Console 

The console connection can be made between a PC and routers or 

switches. The requirements for a PC console session must be met: the 

connection speed on both sides must be the same. 

Copper 

Straight - 

through 

This type of cable is a standard Ethernet transmission medium for 

connecting devices that operates at different levels of OSI. It must be 

connected to the following types of ports: copper 10 Mbps (Ethernet), 

copper 100 Mbps (Fast Ethernet) and copper 1000 Mbps (Gigabit 

Ethernet). 

Copper 

Cross - 

over 

This type of cable is an Ethernet transmission medium for 

connecting devices that operate on the same OSI levels. It can be 

connected to the following types of ports: copper 10 Mbps (Ethernet), 

copper 100 Mbps (Fast Ethernet) and copper 1000 Mbps (Gigabit 

Ethernet). 

Fiber 
Fiber optic media is used to connect between optical ports (100 

Mbps or 1000 Mbps). 

Phone 

A telephone line connection can only be made between devices 

that have modem ports. The standard representation of a modem 

connection is an end device (such as a PC) that is called into the cloud 

network. 

Coaxial 
Coaxial medium is used to connect between coaxial ports, such as 

a cable modem connected to the cloud. 

Serial 

DCE 

and 

DTE 

Serial ports are often used for WAN connections. To set up such 

connections, you must set up synchronization on the DCE side of the 

device. The DCE side can be identified by a small clock icon next to 

the port. When you select a Serial DCE connection type, the first 

device to which the connection is applied becomes a DCE device, and 

the second automatically becomes a DTE.  
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After creating the network, you have to save it by selecting File -> Save or icon 

Save on panels Main Tool Bar. File saved topology has expansion * .pkt. 

Packet Tracer gives possibility simulate work with interface command line        

(CLI - Command Line Interface) operating room iOS system installed on all 

switches and routers. Once connected to a device, we can work with it the way we 

work with the console of a real device. The simulator provides support for almost all 

commands available on real devices. 

We can connect switches or routers to the CLI by clicking on the desired device 

and going to the CLI tab in the properties window. 

To simulate the operation of the command line on the end device (computer), you 

must select the Desktop tab in the properties, and then click on the Command 

Prompt shortcut . 

Working with the simulator 

Packet Tracer allows the user to save the configuration of devices, such as routers 

or switches, in text files. To do this, go to the properties of the desired device and in 

the Config tab, click on the "Export" button to export the Startup Config or 

Running Config configuration. This will give us a dialog box to save the required 

configuration to a file with the extension * .txt. The text of the running configuration 

file , config.txt (default name), is similar to the text of the information obtained when 

using the show running - config command on iOS devices. 

The configuration of each device is stored in a separate text file. The user also has 

the ability to manually change the configuration of the saved file using any text editor. 

To provide the device with saved or edited settings, click the Load button in the 

Config tab to load the required Stàrtup Config configuration or the "Merge" 

button to load the Running Config configuration. 

The size of real networks is much larger than most of the networks we work with, 

to see the network in full, we have to resize the Packet Tracer window.  
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Access Packet Tracer help sections, tutorials, and interactive materials 

There are two ways to access Packet Tracer help topics: 

 click the question mark in the upper right corner of the toolbar menu; 

 open the Help menu and select Contents. 

To open Packet Tracer training videos, choose Help> Tutorials. These videos 

clearly present information from the Help sections, as well as various features of 

Packet Tracer software. Watch the Interface Overview video in the Getting Started 

section of the tutorials. 

Switch between real-time and simulation modes 

Find the word Realtime in the lower right corner of the Packet Tracer interface. 

In real time, the network always acts as real, whether you work with it or not. The 

settings are applied in real time, and the network responds to them in near real time. 

Click the tab directly after the Realtime tab to switch to Simulation mode. In 

simulation mode, the network is displayed at a lower speed, allowing you to monitor 

data acquisition paths and check data packets. Open the simulation panel and click the 

Auto capture / Play button. Now you should see data packets represented by 

envelopes of different colors moving between devices. 

Press the Auto capture / Play button again to stop simulation. 

Click the Capture / Forward button to enable step-by-step simulation. Press the 

button a few more times to see the process in action. In the network topology on the 

left, click one of the envelopes on the intermediate device and examine its contents. 

Switching between logical and physical representation 

Find the word Logical in the upper left corner of the Packet Tracer interface. You 

are now in the Logical workspace; You will use it most often when working with 

networks (building networks, setting up, studying and troubleshooting them , etc. ). 

Click the tab below the Logical area to switch to the Physical workspace . The 

Physical workspace contains the physical dimensions of the logical network topology. 

It allows to estimate the scale and location of elements (for example, how the network 

can look in a real environment). 
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Tasks for laboratory work 1 

 Part 1 of laboratory work 1 

Add two Switch-PT switches to the working area of the simulation environment. 

By default, they are named Switch0 and Switch1.  

Add to the workspace four computers with default names PC0, PC1, PC2, PC3.  

Connect the devices to the Ethernet network, as shown in Figure 1.16. 

        Save the created topology by clicking the Save button (in the File -> Save menu). 

 

Fig.1. 16. Simple network model consisting of two switches and four nodes 

Open the properties of the PC0 device by clicking on its image. Go to the 

Desktop tab and simulate the work of running by clicking Command Prompt. 

Receive the list of commands if we enter " ? " And we press Enter. To configure 

the computer, use the ipconfig command from the command line, for example: 

ipconfig 192.168.1.2 255.255.255.0 

The IP address and network mask can also be entered in the user-friendly 

graphical interface of the device (Fig. 1.17). The DEFAULT GATEWAY field is the 

gateway address not yet required, as the network being created does not require 

routing.  
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Fig.1. 17. Node settings  

On each computer look at the assigned addresses by the ipconfig command 

without parameters.  

Packet Tracer provides a simulation mode that describes in detail and shows how 

the ring utility works.  

Therefore, you have to switch to this mode by clicking on the icon of the same 

name in the lower left corner of the work area, or by pressing  Shift+S. 

 The Simulation Panel will open, displaying all events related to the ping process 

(Fig. 1.18). 

Device IP ADDRESS SUBNET MASK 

PC0 192.168.1.2 255.255.255.0 

PC1 192.168.1.3 255.255.255.0 

PC2 192.168.1.4 255.255.255.0 

PC3 192.168.1.5 255.255.255.0 
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Fig.1.18. Panel simulation in Packet Tracer 

Restart the ping process. After its launch, you can minimize the "Simulation 

Panel" to monitor the sending / receiving of packets in the diagram of the designed 

network. 

 The "Automatic" button means modeling the entire ping process in a single 

process, while "Step by Step" allows to display it step by step. 

 To identify the information contained in the package, its structure, just right-click 

on the colored square in the "Information" column.  

Simulation stops either when the ping process is completed or when the "Edit" 

window of the corresponding workstation is closed. 

If done correctly, we will be able to ping any PC from any computer.  

For example, go to PC3 and ping PC0.  

We should see a ping report similar to fig. 1.19. 
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Fig. 1. 19. Execution of the ping command in the command line 

In the "Simulation Mode" you can not only track the protocols used, but also to 

see which of the seven levels of the OSI model this protocol is involved (Fig . 1.20). 

Fig. 1.20. Analysis of the seven-level OSI model in Packet Tracer 
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Part 2 of laboratory work 1 

1. Create the network topology shown in Fig. 1.21. 

 

Fig.1.21. Network topology for research 

 

2. Assign addresses to computers, according to the option on list v in the table        

(v is the serial number of the student in the group list): 

Device IP ADDRESS SUBNET MASK 

PC0 192.168.v.1 255.255.255.0 

PC1 192.168.v.2 

PC2 192.168.v.3 

PC3 192.168.v.4 

168168v.1.4 PC4 192.168.v.5 

PC5 192.168.v.6 

PC6 192.168.v.7 

 

If done correctly, we can prop up any computer from any other computer. 

Use ping utility according to the table:  
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Option Рing source Ping destination 

1 PC0 PC6 

2 PC1 PC6 

3 PC2 PC0 

4 PC3 PC1 

5 PC4 PC2 

6 PC6 PC3 

7 PC6 PC4 

8 PC6 PC5 

9 PC0 PC5 

10 PC1 PC5 

11 PC2 PC0 

12 PC3 PC1 

13 PC4 PC2 

14 PC6 PC3 

1 5 PC0 PC4 

16 PC1 PC4 

17 PC2 PC0 

18 PC3 PC1 

19 PC4 PC2 

20 PC6 PC3 

21 PC6 PC2 

22 PC0 PC3 

23 PC1 PC2 

24 PC2 PC0 

25 PC3 PC1 

 

 

4. In Simulation Mode, track packet traffic and protocols used. 



37 

 

a) In "Simulation Mode" consider and explain the process of ICMP 

communication between devices (by executing a ring command from one computer to 

another), explain the role of ARP in this process. Include a detailed explanation in the 

report. 

b) Make sure that all network objects are within the IP protocol. 

 

Report requirements for laboratory work 1 

The report should include: 

1. Title page. 

2. Individual task for laboratory work (screenshot of the network topology 

according to and addressing nodes with a decent option in). 

3. Progress. This section consists of a sequential description of the 

significant steps to be performed (indicating their nature), an explanation of the ping 

command, and the contents of the protocols. 

4. Conclusions. 

 

Questions for self-assessment 

1. Which network components do you know? 

2. Describe submarine communications cable. 

3. Describe the difference between Clients and Servers. 

4. Which types of networks do you know? 

5. Describe OSI model layers. 

6. What are network cards used for? 

7. What is the MAC address it has in the form of a record? 

8. Which t types of network environment do you know? 

9. What are the types of copper cables? 

10. What is the structure and features of the use of coaxial cable? 

11. What is the structure and features of the use of twisted pair? What are the 

types of twisted pair? 

12. What is the structure and features of the use of fiber optic lines? 
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13. What are the main characteristics of a wireless environment? 

14. What do you know about wireless data standards? 

15. What types of network topologies do you know? 

16. What are the features of the "star" apology? 

17. What are the features of the "ring" apology? 

18. What are the features of the "bus" apology? 

19. What are the features of the "tree" apology? 

20. Describe the main comparative characteristics of topologies of computer 

networks. 

21. How to switch between logical and physical representation in Packet 

Tracer? 

22. What is the purpose of the ipconfig utility? 

23. What is the purpose of the ping utility? 

24. What is the purpose of the ICMP protocol? 

25. What is the purpose of the ARP protocol? 
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LABORATORY WORK №2. TRACKING THE ROUTE TO A REMOTE 

SERVER FROM THE COMMAND LINE, SOFTWARE AND WEB TOOLS 

Objective: to learn how to test the connection to a remote server, to learn how to 

route to a remote server using the command line and various software and web tools. 

Theory and methodological instructions 

Route-tracing software is a utility that contains lists of networks that must pass 

data from the user's sending end device to the remote destination network. 

Traceroute (tracert) is a utility that is used to test the path between two hosts 

and provide a list of hops that were successfully reached along that path. 

 

Traceroute provides round-trip time for each hop along the path and indicates if a 

hop fails to respond. An asterisk (*) is used to indicate a lost or unreplied packet. 

This information can be used to locate a problematic router in the path or may 

indicate that the router is configured not to reply.  

Traceroute makes use of a function of the TTL field in IPv4 and the Hop Limit 

field in IPv6 in the Layer 3 headers, along with the ICMP Time Exceeded message. 

The first message sent from traceroute will have a TTL field value of 1. This 

causes the TTL to time out at the first router. This router then responds with a ICMPv4 

Time Exceeded message.  

Traceroute then progressively increments the TTL field (2, 3, 4...) for each 

sequence of messages. This provides the trace with the address of each hop as the 

packets time out further down the path. The TTL field continues to be increased until 

the destination is reached, or it is incremented to a predefined maximum. 

To start the trace process, you must enter the following on the command line: 

tracert <destination network name or end device address> 
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(for Microsoft Windows family of operating systems) 

or 

traceroute <destination network name or end device address> 

(for Unix operating systems) 

Route trace utilities allow you to define paths or routes, as well as calculate the 

delay time in the IP network. There are several tools to perform this function. 

The traceroute tool (or tracert) is used to find and troubleshoot network 

problems. It displays a list of routers passed and allows you to determine which path 

was used to reach a destination on one network or when switching between multiple 

networks. Each router is a connection point between two networks through which data 

packets are sent. The number of routers is the number of "transitions" made by the data 

from the source to the destination. 

The list that appears helps determine what data issues are occurring when we try 

to access a service, such as a website. The list can also be used when downloading 

data. If the same file is available on multiple websites (mirrors), we can check the 

route for each mirror and choose the fastest option. 

Two route traces performed between the same source and destination nodes, but 

at different times, may give different results. This may be due to the "fully connected" 

nature of interconnected networks, consisting of the ability of the Internet and Internet 

protocols to choose different cable channels for sending packets.  

Route tracing using the command line are usually embedded in the operating 

system of the end device (node). 

One PC (Windows 7, Vista or XP with Internet access) is used for this laboratory 

work. Using an Internet connection and three different route tracing utilities, you have 

to track the path of data packets over the Internet to destination networks. This uses a 

computer, an Internet connection, and command line access. First we use the "tracert" 

utility built into Windows, then the web tools for tracing the route 

(http://www.subnetonline.com/pages/network-tools/online-traceroute.php). 

 

 

http://www.subnetonline.com/pages/network-tools/online-traceroute.php
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ICMP (Internet Control Message Protocol) echo responses used by ping echo 

requests and trace commands are disabled. Before you begin this task, verify that there 

are no local restrictions associated with ICMP datagrams. This paper assumes that 

ICMP datagrams are not restricted by any local security policies. 

Check the network connection with an echo request using the ping command 

Check if a remote server is available. To route to a remote network, the PC must 

be connected to the Internet. 

First, use the echo query with the ping command. An echo query with the ping 

command is a means to check the availability of a node. Information packets are sent 

to the remote host with a response request. The local PC determines whether a 

response is received for each packet , and calculates how long it takes to send these 

packets over the network. The name "echo request" came from the area of active sonar, 

where it meant an audible signal sent underwater and reflected from the bottom or 

other ships.  

Click Start on the computer screen, type cmd in the Find programs and files box, 

and then press ENTER. 
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At the command prompt, enter ping www.cisco.com  

 

The first line of the received data displays the fully qualified domain name 

(FQDN) e144.dscb.akamaiedge.net. This is followed by the IP address 23.1.48.170. 

Cisco Web sites that contain the same information are hosted on different servers (so-

called mirrors) around the world. This means that the FQDN name and IP address 

will differ depending on your location. 

Let's take some of the results: 

 

It shows that four echo requests were sent using the ping command , each of 

which was answered. The response to all echo requests was received using the ping 

command, so there are no packet losses (0% of losses). On average, 54 ms 

(milliseconds) are required to transmit packets over the network. 

If the waiting time for the first ICMP packet has expired, this may be due to the 

PC converting the destination address. This will not happen if the echo request is 

repeated with the ping command when address caching. 

Loss of packets or slow network connection primarily affects the quality of 

streaming video and online games. To determine the speed of the Internet connection 

more accurately, you can send not 4 echo requests using the default ping command, 

but 100. To do this, use the following command. 

 

http://www.cisco.com/
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The result will look like this. 

 

Now let's look at the case where all ping echo requests were sent from a 

computer located in the United States to regional Internet Registry (RIR) websites 

located in different parts of the world. 

Africa: 

C: \> ping www.afrinic.net 

 

Australia: 

C: \> ping www.apnic.net 

 

Europe : 

C: \> ping www.ripe.net 
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South America: 

C: \> ping lacnic.net 

 

 

When data is transmitted using the ping command within one continent (North 

America), the average echo request time (in milliseconds) increases significantly 

compared to when data from North America is transmitted to other continents. In this 

case, echo requests using the ping command sent to the European website from the 

United States were not successful. 

 

Trace a route to a remote server with the traceroute tools 

 

Determine which route of all Internet traffic is directed to a remote server. After 

checking the reach with the ping utility, you should take a closer look at each network 

segment through which the data passes. To do this, use the tracert command.  

At the command prompt, enter tracert www.cisco.com. 
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Save the results obtained after entering the tracert command in a text file by 

following the steps below. 

2) Right-click on the title bar of the command prompt and select Edit> Select 

All. 

3) Right-click the title bar of the command prompt again and select Edit> Copy. 

4) Open Windows Notepad. To do this, click Start and select All Programs> 

Accessories> Notepad. 

5) To paste data into Notepad, choose Paste from the Edit menu. 

6) On the File menu, click Save As, and then save your Notepad file to your 

desktop as tracert1.txt. 

Run the tracert utility for each destination website and save the results to 

sequentially numbered files. 

C: \> tracert www.afrinic.net 

C: \> tracert www.lacnic.net 

Depending on the coverage area of ISP and the location of the source and 

destination nodes, tracked routes can cross many transitions and networks.  

Each transition is one router. A router is a special computer that is used to redirect 

traffic over the Internet. Imagine that we went on a trip on the roads of several 

countries. During your journey, you constantly come to a fork where you have to 

choose one of several destinations. Now imagine that at each fork there is a device that 

indicates the right path to the final destination of our journey. The router for packets 

on the network does the same. 

Because computers use the language of numbers, not words, routers are assigned 

unique IP addresses (xxxx numbers). The tracert utility shows which way the data 

packet goes to the final destination. You can use the tracert utility to determine how 

fast traffic passes through each network segment. Each router receives three packets on 

the data path, the response time of which is measured in milliseconds. Using this 

information, analyze the results obtained with the tracert utility when sending 

packages to www.cisco.com . Below is the entire route of the route. 
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In this example, packets sent by the tracert utility are forwarded from the source 

PC to the primary gateway of the local router (transition 1: 192.168.1.1) and then to 

the router at the POP connection point (transition 2: 10.18.20.1). Each provider has 

many POP routers. They mark the boundaries of the ISP's network and serve as 

Internet connection points for customers. The packets are transmitted over the Verizon 

network, cross two transitions and end up in a router owned by alter.net. This may 

mean that the packets have reached another ISP. This point is very important, because 

packets can be lost when sending packets from one provider to another, and it is 

important to remember that not all ISPs are able to provide the same data rate. How to 

determine whether alter.net is the same or a different ISP? 

There is an online service whois, which can be used to identify the owner of a 

domain name. The whois service is available at http://whois.domaintools.com/.  

Thus, Internet traffic starts on the home PC and passes through the home router 

(transition 1). It then connects to the ISP and is transmitted over its network 

(transitions 2-7) until it reaches a remote server (transition 8). This is a rather unusual 

example, in which only one provider is involved from start to finish. As can be seen 

from the following examples, most often two or more ISPs are involved in data 

transfer. Now let's look at an example of forwarding Internet traffic across multiple 

ISPs. Below are the results of using the tracert utility to www.afrinic.net. 
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What happens in transition 7? Is level3.net the same ISP as in transitions 2-6? To 

answer this question, use the whois service, where we determine that Internet traffic 

passes from the node alter.net to the node level3.net. The whois service reports that it 

is a separate company or other Internet provider. 

         What happens in transition 18? With the help of the whois service we will 

perform a search at the address 168.209.201.74. The transition time on one channel in 

the network increases from 159 to 340 ms. This may mean that traffic has moved from 

the Tier 3 backbone to another network. With the help of the whois service we 

establish that the IP address 168.209.201.74 belongs to the African Network 

Information Center. 



48 

 

Enter the tracert www.lacnic.net. 

 

We see that during the transition the packet travel time on the network (in ms) can 

increase more than four times (route from Kyiv, Ukraine). 

 

Track a route to a remote server using software and web tools 

We will use the web tool for tracing the route. Use 

http://www.subnetonline.com/pages/network-tools/online-tracepath.php to track 

the route to www.cisco.com and www.afrinic.net . 

www.cisco.com : 

TracePath Output: 

 

www.afrinic.net : 

TracePath Output: 

1: pera.subnetonline.com (141,138,203,105)                                       0.175ms  

1: gw - v130.xl - is.net (141.138.203.1)                                               0.920ms 

http://www.cisco.com/
http://www.afrinic.net/
http://www.cisco.com/
http://www.afrinic.net/
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2: rt - eu01 - v2.xl - is.net (79.170.92.19)                                             0.556ms 

3: xl - internetservices.nikhef.openpeering.nl (217.170.0.225)             10.679ms 

4: r22.amstnl02.nl.bb.gin.ntt.net (195.69.144.36) asymm                     54.412ms 

5: ae - 5.r23.londen03.uk.bb.gin.ntt.net (129.250.5.197)                       49.349ms 

6: ae - 2.r02.londen03.uk.bb.gin.ntt.net (129.250.5.41) asymm            78.842ms 

7: dimensiondata - 0.r02.londen03.uk.bb.gin.ntt.net (83.231.235.222) 18.080ms 

8: 168,209,201.74 (168,209,201.74)                                                       196.375ms 

9: csw4 - pkl - gi1 - 1.ip.isnet.net (196.26.0.101) asymm                      10 186.855ms 

10: 196.37.155.180 (196.37.155.180)                                                     185.661ms 

11: fa1 - 0-1.ar02.jnb.afrinic.net (196.216.3.132)                                   197.912ms 

 

In this example, the command line routing was completed on a server in 

Cambridge, Massachusetts. Tracing the route from a website in the Netherlands 

resulted in a mirror server in the same country. The cisco.com domain is hosted on 

several websites (mirrors) located around the world. This is done in order to minimize 

access time to the site from anywhere in the world. 

Let's compare the results of tracing a route to Africa from part 1 with the results 

of tracing the same route through the web interface. What is the difference between 

them? The route through Europe is provided by another Internet provider. 

There are many trunk channels on the Internet. They all connect at points of 

exchange. The network performance of one ISP may differ from the network 

performance of another. 

In some route trace results, you can see the expression "asymm" –  an 

abbreviation of the word asymmetric, ie "asymmetric". It means that the test package 

reached its destination one way and returned another. Imagine that you went by car to 

the city of Chernihiv. Along the way, you discovered what was created problems on 

the road and traffic are extremely difficult. We have decided to return home the other 

way, that is, you have chosen an asymmetrical path. 
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Comparison of tracing results 

Let's compare the results of tracing the route to www.cisco.com to see if all the 

tracing tools used the same routes to www.cisco.com or different. Here are the 

addresses on the route to www.cisco.com, obtained using the tracert command: 

192.168.1.1> 10.18.20.1> 130.81.196.190> 130.81.22.46> 152.63.1.57> 

152.63.17.109> 152.63.21.14> 23.1.144.170. 

Here are the addresses on the route to www.cisco.com, obtained through the web 

service subnetonline.com: 

141,138,203,105> 141,138,203.1> 79,170.92.19> 19,239,116,226 

  Route tracing performed between the same source and destination nodes, but at 

different times, can give different results. This may be due to the "fully connected" 

nature of interconnected networks, consisting of the ability of the Internet and Internet 

protocols to choose different cable channels for sending packets. 

 

Tasks for laboratory work 2 

You have to check the ability to connect to a remote server (optional) using the 

ping utility, https://whois.domaintools.com/ and using three different route tracing 

tools (tracert utility, web interface https://www.subnetonline.com/pages/network-

tools/online-tracepath.php). Compare and explain the results of the trace, as described 

in the instructions for the task. 

 

  Version Remote server 

1 www.facebook.com 

2 www.java.com 

3 www.netacad.com 

4 www.intel.com 

5 www.linkedin.com 

6 www.google.com 

7 www.av-intel.com 

8 www.agri-intel.com 

http://www.cisco.com/
http://www.cisco.com/
https://whois.domaintools.com/
https://www.subnetonline.com/pages/network-tools/online-tracepath.php
https://www.subnetonline.com/pages/network-tools/online-tracepath.php
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9 www.gmail.com 

10 www.cisco.com 

11 www.scopus.com 

12 www.bbc.com 

13 www.telegram.org 

14 www.oracle.com 

15 www.phyton.com 

16 www.w3schools.com 

17 www.apple.com 

18 www.ford.com 

19 www.facebook.com 

20 www.netacad.com 

21 www.google.com 

22 www.meta.com 

23 www.linkedin.com 

24 www.scopus.com 

  25 www.microsoft.com 

 

 

Report requirements for laboratory work 2 

The report should include: 

1. Title page. 

1. Individual task for laboratory work (screenshot of the task with a decent 

option in). 

2. Workflow (sequential description of the performed steps (with 

screenshots of execution), explanation of the work of the team of utilities, software and 

web tools for tracing the route to a remote server, comparing the results of tracing). 

3. Conclusions. 

 

 

 



52 

 

Questions for self-assessment 

1. What are the ping, tracert utilities used for? and traceroute? 

2. What software and web resources do you know for tracing a route to a remote 

server? 

3. Why the results of tracing by different means may differ? 

4. What does the expression "asymm" mean in the route trace results? 

5. Why we use web resources ONLINE TRACEPATH)? 

References 

1. Mapping the Internet https://www.academia.edu/12778956/ 

2. Online Tracepath. URL: https://www.subnetonline.com/pages/network-

tools/online-tracepath.php 

3. Whois Lookup. URL: https://whois.domaintools.com 

4. What is Traceroute. URL: 

https://www.fortinet.com/resources/cyberglossary/traceroutes 

 

LABORATORY WORK № 3. COLLECTION AND ANALYSIS OF ICMP 

DATA USING WIRESHARK 

Objective: to learn to use the program Wireshark to collect and analyze ICMP 

data, to intercept the IP address of ICMP data packets and MAC addresses of Ethernet 

frames from local and remote nodes. 

Theory and methodological instructions 

Wireshark is a protocol analysis program (packet analyzer) used to troubleshoot, 

analyze, develop software and protocols. As data flows over the network, the analyzer 

intercepts each protocol data unit (PDU) and then decrypts or analyzes its contents in 

accordance with the relevant RFC document or other specifications. Windows 7, Vista 

or XP with Internet access is used for laboratory work, additional PCs in the local 

network are needed to respond to echo requests (ping command) on other computers 

in the local network. 

https://www.academia.edu/12778956/
https://www.subnetonline.com/pages/network-tools/online-tracepath.php
https://www.subnetonline.com/pages/network-tools/online-tracepath.php
https://whois.domaintools.com/
https://www.fortinet.com/resources/cyberglossary/traceroutes
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Wireshark installation procedure and screenshots may differ depending on the 

version of the program. This lab describes the use of Wireshark version 1.8.3 for 

Windows 7 (64-bit version). 

Download and install Wireshark 

Wireshark is a standard packet analyzer used by network engineers. Versions of 

this open source program are available for a variety of operating systems, including 

Windows, Mac, and Linux. 

Download Wireshark at www.wireshark.org  

 

 

 

http://www.wireshark.org/
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Choose the version of the program according to the architecture and operating 

system of your PC. For example, if your PC is running a 64-bit Windows operating 

system, select Windows Installer (64-bit). 

 

 

The download will start immediately after that. The location of the downloaded 

file depends on the browser and operating system you are using. 

 The downloaded file is called Wireshark - win64 - xxxexe, where "x" 

corresponds to the number version of it . Double-click the file to begin the installation. 

Respond to all security messages that appear on the screen.  

If you already have a copy of Wireshark on your PC, you will be prompted to 

uninstall the old version before installing the program. 

 It is recommended that you uninstall the old version of the program before 

installing the new one. To uninstall a previous version of Wireshark, click Yes. 
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If you are installing Wireshark for the first time or a previous version has been 

uninstalled, the Wireshark Installation Wizard will open. Click Next. 

 

 

 

Follow the installation instructions. When the "License Agreement" window 

opens, click the I accept button. 
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When selecting components, leave the default setting and click Next. Select the 

desired shortcuts and click Next. 

 

    

 

If disk space is limited, we can change the installation directory, otherwise leave 

the default address. 

 

 

To collect network data on your PC you have to install WinPcap. If the installed 

version of WinPcap is older than the version included with Wireshark, you must install 

the newer version by clicking the check box next to Install WinPcap xxx (Install 

WinPcap xxx). If the installation is successful, close the WinPcap installation wizard. 
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After that, the installation of Wireshark will begin. The status of the installation 

will be displayed in a separate window. When the installation is complete, click Next. 

Click Finish to complete the Wireshark installation process. 

 

 

 

Collection and analysis of ICMP data on local nodes in Wireshark 

We send echo request using the ping command to another PC on the local 

network and intercept ICMP requests and feedback in Wireshark. At the same time, 

find the necessary information in the collected frames. This analysis will help  

understand how packet headers are used to transmit data to a destination. 

Define the addresses of our PC interfaces. In this lab you have to find out the IP 

address of your computer and the physical address of the network adapter (MAC 
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address). Open a command prompt window, type ipconfig/all, and then press ENTER. 

Write down the IP address of the PC interface and the MAC address. 

 

Share IP addresses with a colleague, but do not tell your MAC address yet. Start 

Wireshark and start intercepting data. 

On your PC, click the Start / Wireshark button. 

Wireshark program , click on the Interface parameter list (List of interfaces). 

 

 

You can also open the list of interfaces by clicking on the icon of the first 

interface in a number of icons. 
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In the Wireshark Capture Interfaces window, select the check box next to the 

interface connected to your local network. 

 

 

If several interfaces are listed and you are not sure which one to choose, click the 

Details button and open the 802.3 (Ethernet) tab. Make sure that the MAC address a 

matches the result you received earlier. After making sure the interface is correct, close 

the information window. 

 

 

 

Then click the Start button to start intercepting data. 

 

 

Information will scroll to the top of the Wireshark window. Data strings are 

highlighted in different colors depending on the protocol. 
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Information can scroll very quickly depending on the type of connection between 

the PC and the local network. You can apply a filter to make it easier to view and work 

with the data collected by Wireshark. In this lab, we only need the ICMP. To display 

only the ICMP (ping echo request) protocol blocks, enter icmp in the filter field at the 

top of the Wireshark window and press the ENTER key or the Apply button. 

 

 

After that, all the data in the upper window will disappear, but the interception of 

traffic in the interface will continue. Open a command prompt window that you 

opened earlier and send an echo request using the ping command to the IP address 

obtained from another student. Note that the data will reappear at the top of the 

Wireshark window. 
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Stop data interception by clicking the Stop Capture icon. 

 

Analyze the data obtained. If another student 's computer does not respond to 

your echo requests, it may be because your computer's firewall is blocking those 

requests. 

 

Skip ICMP traffic through Windows Firewall 

If ping commands from other computers do not pass to your PC, they may be 

blocked by a firewall. Firewall is a device that allows to deny, encrypt, pass through a 

proxy all computer traffic between areas of different security according to a set of rules 

and other criteria. 

 

https://uk.wikipedia.org/wiki/%D0%9F%D1%80%D0%B8%D1%81%D1%82%D1%80%D1%96%D0%B9
https://uk.wikipedia.org/wiki/%D0%9F%D1%80%D0%BE%D0%BA%D1%81%D1%96
https://uk.wikipedia.org/wiki/%D0%A2%D1%80%D0%B0%D1%84%D1%96%D0%BA
https://uk.wikipedia.org/wiki/%D0%91%D0%B5%D0%B7%D0%BF%D0%B5%D0%BA%D0%B0
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Fig. 4.1. Schematic representation of the firewall 

The firewall can be as a stand-alone device (a router), or as software installed on 

a personal computer or proxy server. Depending on the active compounds being 

monitored, firewalls are divided into: stateless (simple filtering), which do not monitor 

current connections (eg. TCP), but filter the data flow solely on the basis of static 

rules; stateful (context-sensitive filtering), tracking current connections and skipping 

only those packets that satisfy the logic and algorithms of the relevant protocols and 

programs. These types of firewalls allow you to more effectively combat various 

DDoS attacks and vulnerabilities in some network protocols. 

  There are three types of firewalls: network layer, application layer and 

connection layer. Each of these types uses its own different approach to network 

protection. 

 Network-level firewalls are represented by and shielding and router. They 

control only the data of the network and transport levels of the service information 

packets. The disadvantage of such routers is that five more levels remain uncontrolled. 

Administrators working with shielding routers should keep in mind that most packet 

filtering devices do not have auditing and alarm mechanisms. In other words, routers 

can be attacked and repel large numbers, and administrators will not even be informed. 

Branmauer applied level or proxy server and (proxy servers) establish a certain 

physical separation between the local network and the Internet, so they meet the 

highest security requirements, the proxy server uses faster computers. 

To perform laboratory work it is necessary to pass echo requests by means of the 

ping command through a firewall and to cancel a new firewall rule after lab work. 

It is necessary to create a new rule that allows the passage of ICMP traffic through the 

firewall. To do this, in the control panel, select System and Security. 

https://uk.wikipedia.org/wiki/%D0%9C%D0%B0%D1%80%D1%88%D1%80%D1%83%D1%82%D0%B8%D0%B7%D0%B0%D1%82%D0%BE%D1%80
https://uk.wikipedia.org/wiki/%D0%9F%D0%B5%D1%80%D1%81%D0%BE%D0%BD%D0%B0%D0%BB%D1%8C%D0%BD%D0%B8%D0%B9_%D0%BA%D0%BE%D0%BC%D0%BF%27%D1%8E%D1%82%D0%B5%D1%80
https://uk.wikipedia.org/wiki/TCP
https://uk.wikipedia.org/wiki/%D0%9C%D0%B0%D1%80%D1%88%D1%80%D1%83%D1%82%D0%B8%D0%B7%D0%B0%D1%82%D0%BE%D1%80
https://uk.wikipedia.org/wiki/%D0%9C%D0%B0%D1%80%D1%88%D1%80%D1%83%D1%82%D0%B8%D0%B7%D0%B0%D1%82%D0%BE%D1%80
https://uk.wikipedia.org/wiki/%D0%9C%D0%B0%D1%80%D1%88%D1%80%D1%83%D1%82%D0%B8%D0%B7%D0%B0%D1%82%D0%BE%D1%80
https://uk.wikipedia.org/wiki/%D0%9F%D1%80%D0%BE%D0%BA%D1%81%D1%96-%D1%81%D0%B5%D1%80%D0%B2%D0%B5%D1%80
https://uk.wikipedia.org/wiki/Internet
https://uk.wikipedia.org/wiki/%D0%A1%D0%B5%D1%80%D0%B2%D0%B5%D1%80
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In the System and Security window, select Windows Firewall. 

On the left side of the Windows Firewall window, select Advanced Options. 

Inbound Connection Rules in the left sidebar, and then click Create Rule in the 

right sidebar. 

The Create New Rules for Inbound Connections wizard opens. In the Rule Type 

window, select the Customizable radio button, and then click Next. 

In the left pane, select Protocols and Ports and select ICMPv4 from the protocol 

type drop-down menu. 

Then click Next. In the left pane, select Name and enter Allow in the 

appropriate field ICMP Requests. Click the Finish button. 

The created rule will allow another student to receive feedback from PC. 

Disable and delete the new ICMP rule. At the end of the laboratory work, you 

must disable or delete the newly created rule. The Disable rule option will allow 

you to re-enable it if necessary. Deleting a rule completely will permanently remove it 

from the list of rules for incoming connections. 

On the left side of the Advanced Security Settings window, select Inbound 

Connection Rules , and find the rule you created in step 1. 

To disable a rule, select the Disable Rule option. It will then change to the 

Enable Rule option. The rule can be turned on and off. The status of the rule is 

displayed in the " Enabled " column of the list of rules for incoming connections. 

Delete option. You will then need to create this rule again to allow ICMP 

requests. Further you have to check the data generated by ho -queries using the ping 

command of another student's PC. Wireshark displays data in three sections: 

1) the top section displays a list of received PDU frames with summary 

information about IP packets; 

2) the middle section provides information about the PDU for the frame selected 

in the upper part of the screen, and the division of the PDU frame into layers of 

protocols; 

3) the lower section shows the raw data of each level. 

 Raw data is displayed in both hexadecimal and decimal formats. 
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Select the PDU frame and the first ICMP request at the top of the Wireshark 

window. Note that the Source column lists the IP address of your computer, and the 

Destination column lists the IP address of the PC to which you sent the echo request 

using the ping command. 

 

 

Without changing the PDU frame selection in the top section of the program, go 

to the middle section. Click on the + symbol to the left of the "Ethernet II" line to see 

the MAC addresses of the source and destination. 
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Does the source MAC address match your computer's interface? 

Does the MAC address of the destination in Wireshark match the MAC address 

of another student? How did your PC determine the MAC address of the PC to which 

the echo request was sent using the ping command? In the intercepted ICMP request 

example, the ICMP protocol data is encapsulated within the IPv4 PDU packet (IPv4 

header), which is then encapsulated in the Ethernet II frame packet (Ethernet II header) 

for transmission over the local network. 

Collection and analysis of ICMP data on remote nodes in Wireshark 

Next, you have to send echo requests using the ping command to remote nodes 

(nodes outside the local network) and examine the data generated by these requests. 

You will then identify the differences between this data and the data studied for the 

local network. Start data interception in the interface.  Click on the Interface icon List 

to reopen the list of PC interfaces. 
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Make sure that a check box is selected in front of the LAN interface, and click the 

Start button. 

 

A window will appear asking you to save the previously received data before 

starting a new interception. It is not necessary to keep this data. Click Continue 

without Saving. 

 

Tasks for laboratory work 3 

1. Set up a local network with another student and collect ICMP data using 

Wireshark according to the instructions for the laboratory work. Check that you have 

correctly identified your own MAC address and the MAC address of another student 

(in the screenshot of this task you have to paint the first / last three characters of the 

received MAC addresses based on the confidentiality of information). 

2. Intercept ICMP data for two remote servers. After enabling data interception, 

send a ping echo request to the URLs of Server 1 and Server 2  to verify connectivity.   

When ping queries to the specified URLs, note that the Domain Name Service 

(DNS) will convert the URL to an IP address. Write down the IP addresses obtained 

for each URL (addresses may differ).  

Stop data interception by clicking the Stop Capture icon. 

 

Analyze the data obtained from remote nodes. View the data collected and 

examine the IP and MAC addresses of the websites you visit. 
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 Enter the IP and MAC address and destination for the websites: 

Server 1 : IP: _____._____._____._____ MAC: ___ _: _ ___: ____: ____: ____: ____ 

Server 2 : IP: _____._____._____._____ MAC: ___ _: _ ___: ____: ____: ____: ____ 

What is special about this data? Wireshark show the actual MAC address of local 

nodes but not the actual MAC address of remote nodes? 

Version Server 1 Server 2 

1  www.java.com  www.yahoo.com 

2  www.google.com  www.cisco.com 

3  www.gmail.com  www.facebook.com 

4 www.ford.com www.gmail.com 

5 www.cisco.com www.phyton.com 

6 www.apple.com www.telegram.org 

7 www.oracle.com www.bbc.com 

8 www.scopus.com www.w3schools.com 

9  www.linkedin.com  www.java.com 

10 www.java.com www.chevron.com 

11 www.yahoo.com www.scopus.com 

12 www.gmail.com www.verizon.com 

13 www.chevron.com www.linkedin.com 

14 www.w3schools.com www.google.com 

15 www.linkedin.com www.apple.com 

16 www.microsoft.com www.facebook.com 

17 www.cisco.com www.scopus.com 

18 www.pepsico.com www.aig.com 

19 www.scopus.com www.gmail.com 

20 www.apple.com www.cisco.com 

21 www.google.com www.yahoo.com 

22 www.facebook.com www.ford.com 

23 www.w3schools.com www.java.com 

24 www.chevron.com www.microsoft.com 

25 www.scopus.com www.cisco.com 
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Report requirements for laboratory work 3 

The report should include: 

1. Title page. 

2. Individual task for laboratory work. 

3. The course of work, sequential description of the steps performed with 

screenshots. 

4. Conclusions. 

 

Questions for self-assessment 

1. What is the purpose of Wireshark and what are the features of its use? 

2. What is the structure of the Wireshark window? 

3. What is the sequence of actions for the collection and analysis of ICMP data by 

Wireshark ? 

4. What is the purpose of a firewall? 

5. What are the types of firewalls? 

6. Why does Wireshark show the actual MAC address of local nodes but not the 

actual MAC address of remote nodes? 

 

 References 

1. Wireshark. URL: www.wireshark.org 

2. What Is Firewall. URL: https://www.simplilearn.com/tutorials/cyber-security-

tutorial/what-is-firewall 

3. PDU. URL: https://www.geeksforgeeks.org/protocol-data-unit-pdu/ 

 

  

http://www.wireshark.org/
https://www.simplilearn.com/tutorials/cyber-security-tutorial/what-is-firewall
https://www.simplilearn.com/tutorials/cyber-security-tutorial/what-is-firewall
https://www.geeksforgeeks.org/protocol-data-unit-pdu/
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LABORATORY WORK № 4. IP ADDRESSING.  

NETWORK SUBNETTING 

Objective: to learn to calculate the number of subnets and nodes by subnet 

prefix, to calculate the network address, as well as to use online calculators to calculate 

the basic quantitative and qualitative indicators of specified networks. 

Theory and methodological instructions 

IP addressing 

IP addressing is used everywhere. When you post on social networks, watch 

videos on YouTube, or download programs, and it doesn’t matter if you have a 

computer or a smartphone – everywhere, IP addressing is used for communication.  

In real life, when we send a letter to someone, we must include the recipient's 

address on the envelope as well as your address (sender's address). Without this, the 

letter will not find its recipient and you will not be able to receive a response to this 

letter. The same thing happens in computer networks – in order for one computer to 

send a message to another computer, it must know the address of the recipient 

computer, and also provide information about its address to receive a response. This 

address assigned to a computer is called an IP address. 

To identify a computer or other network device, it is enough to know two 

parameters: IP address and netmask. 

For example: 

IP:    192.168.2.102  

Netmask:    255.255.255.0 

In fact, the IP address 192.168.2.102 and the Mask 255.255.255.0 are just an 

abstraction, representing a number in a decimal, human-readable format. 

The computer sees these numbers in binary format. To store an IPv4 address, 32-

bit variables are used, one byte is equal to 8 bits -> 4 * 8 = 32 –  hence the four in 

IPv4, that is, these are 32-bit numbers consisting of a combination of 32 zeros and 

ones. 
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The IPv4 address and subnet mask for a computer looks like this: 

Address: 11000000101010000000001001100110 

Netmask: 1111111111111111111111100000000 

As you can see, for a person, these zeros and ones say little, therefore, for ease of 

perception, these sequences of zeros and ones are divided into blocks of 8 bits, octets: 

Address: 11000000.10101000.00000010.01100110 

Netmask: 11111111.11111111.11111111.00000000 

It’s already easier, but the problem has not gone away, even breaking a 32-bit 

number into 4 octets, the situation with perception has not improved, a person still 

perceives numbers written in decimal format most easily. 

Address: 11000000.10101000.00000010.01100110 (192.168.2.102) 

Netmask: 11111111.11111111.11111111.00000000 (255.255.255.0) /24 

Instead of 11000000101010000000001001100110 -> 192.168.2.102. An IP 

address written in this format is much easier to remember. 

Each of the four octets can take a value from 0 to 255 (255 = 28 - 1), in binary 

equivalent from 00000000 to 11111111. 

Translating numbers from one number system to another 

When working with computers and network devices, network professionals use 

binary, decimal, and hexadecimal numbers. Microsoft 's operating system includes a 

built-in calculator. The calculator version in Windows 7 includes a regular mode that 

can be used to perform simple arithmetic tasks, as well as advanced capabilities for 

software, scientific and statistical calculations. Click the Windows Start button and 

select All Programs. Open the "Standard" folder and click on "Calculator". When the 

calculator opens, select the "View" menu. Four modes are available: Normal, 

Engineering, Programmer and Statistics. 

Several number systems are available in Windows Calculator Programmer mode : 

Hex (hexadecimal with base 16), Dec (decimal with base 10), Oct (octal with base 8) 

and Bin (binary with base 2). Computers and other electronic devices for storing and 

transmitting data, as well as numerical calculations, use a binary system consisting 



71 

 

only of zeros and ones. All computer calculations are performed in binary (digital) 

form, regardless of the form in which they are displayed. Hexadecimal numbers are 

based on 16, and a combination of digits 0 to 9 and letters A to F is used to represent 

binary or decimal equivalents. Hexadecimal characters are used to represent IPv6 and 

MAC addresses.  

Tasks for laboratory work 4 

In this laboratory work you have to fill in all the blank fields of the tables and 

answer the questions posed in the instructions for laboratory work. 

Use Windows 7 calculator to convert numbers between different number systems 

in "Programmer" mode.  

Open the View menu and select Programmer mode. Convert the following 

numbers to binary, decimal, and hexadecimal: 

Decimal format Binary format Hexadecimal format 

175   

204   

19   

77   

56   

147   

228   

 

Convert IPv4 -address nodes and subnet masks to binary number system 

IPv 4-addresses and subnet masks are expressed in decimal format with a 

semicolon (four octets), such as 192.168.1.10 and 255.255.255.0, respectively. 

 Each decimal octet in the address or mask can be converted to 8 binary digits. 

Octets are always 8 binary bits. So The IPv 4 address will contain 32 bits of zeros 

and ones. 

Using the Windows calculator, convert the IP address 192.168.1.10 to binary 

format and write it in the following table: 
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Decimal format Binary format 

192  

168  

1  

10  

 

Subnet masks, such as 255.255.255.0, are also displayed in decimal format with a 

semicolon. The subnet mask always consists of four 8-bit octets, each of which is 

expressed as a decimal number. Use the Windows calculator to convert the eight 

possible decimal values of the subnet mask octets to binary numbers and write them in 

the following table: 

Decimal format Binary format 

0  

128  

192  

224  

240  

248  

252  

254  

255  

 

Using a combination of IPv 4 addresses and subnet masks, you can determine the 

network part and calculate the number of nodes available in this IPv 4 subnet. 

Determining the number of nodes in the network using two digits 

You can determine the network part and the number of nodes available in the 

network by the IPv4 network address and subnet mask. 
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To calculate the number of nodes in the network, you must determine the network 

and node parts of the address. 

The address and mask of the subnet are converted to binary numbers on the 

example of the address 192.168.1.10 with the subnet 255.255.248.0. When writing the 

results of data translation in binary numbers, set the bits. 

 

IP address and subnet 

mask in decimal format 

IP address and subnet mask in 

binary format 

192.168.1.10  

255.255.248.0  

 

(Since the first 21 bits in the subnet mask are consecutive units, this is the 

network part of the address, the others 11 bits are a node of the address). 

Since the network number and the broadcast address use two addresses from the 

subnet, to determine the number of available nodes in the IPv4 subnet, you have to 

raise the number 2 to the power of the number of node bits and subtract 2. 

Number of available nodes = 2 ^ ( number of bits per node) - 2 

Approximately 2046 nodes (2 ^ 11-2) are available in this network. Knowing the 

number of node bits, determine the number of available nodes and write this value in 

the table below. 

Number of available node bits Number of available nodes 

5  

14  

24  

10  

 

For this subnet mask, determine the number of available nodes and write the 

answer in the table below. 
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Subnet mask Binary subnet mask 

Number of 

available 

node bits 

Number 

of 

available 

nodes 

255.255.255.0 11111111.11111111.11111111.00000000   

255.255.240.0 11111111.11111111.11110000.00000000   

255.255.255.128 11111111.11111111.11111111.10000000   

255.255.255.252 11111111.11111111.11111111.11111100   

255.255.0.0 11111111.11111111.00000000.00000000   

 

Convert MAC and IPv6 address to binary form 

For convenience, the address of the control of access to the data medium and the 

address of the Internet Protocol version 6 (IPv6) are expressed in hexadecimal digits. 

However, computers are able to recognize and use only binary digits for calculations. 

MAC address (physical address) is usually expressed by 12 hexadecimal digits 

grouped in pairs and separated by hyphens (-). On Windows computers, physical 

addresses are usually xx - xx - xx - xx - xx - xx , where x is a digit from 0 to 9 or a 

Latin letter from A to F. Each hexadecimal digit in the address can be converted into 

four binary digits understandable to a computer. 

 

Convert IPv6 addresses to binary 

For convenience, IPv6 addresses are also written in hexadecimal characters. For 

computers, these IPv6 addresses can be converted to binary digits. IPv 6-address is a 

binary number represented as a human-readable record: 2001: 0 DB 8: ACAD : 0001: 

0000: 0000: 0000: 0001 or in short form: 2001: DB 8: ACAD : 1 :: 1 . 

The length of the IPv6 address is 128 bits. Using the Windows calculator, 

convert the IPv6 address to binary number and record the result in the table below. 
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Hexadecimal format Binary format 

2001  

00DB8  

ACAD  

0001  

0000  

0000  

0000  

0001  

 

Convert IPv4 address to binary number system 

Each IPv4 address consists of two parts –  network and node. The network part of 

the address is the same for all devices that are on the same network. The node part 

defines a specific node within the corresponding network. The subnet mask is used to 

determine the network part of the IP address. Devices in one network can exchange 

data directly; an intermediate level 3 device, such as a router, is required to 

communicate between devices on different networks. 

To understand the principle of operation of devices in the network, you need to 

see the addresses in the form in which they work with devices –  in binary 

representation. To do this, you must convert the IP address and its subnet mask from a 

decimal representation with dots to binary. You can then determine the network 

address using the AND operation. 

Consider the procedure for determining the network and node parts of the IP 

address. To do this, translate the addresses and subnet masks from the decimal 

representation with dots to binary format, and then apply the bitwise operation AND. 

Then use the information to determine the addresses in the network. 

You must first convert the decimal numbers to the binary equivalent. After 

completing this task, convert IPv4 addresses and subnet masks from decimal points to 

binary. 
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Complete the table by converting a decimal number to an 8-bit binary value. The 

first number has already been converted for example. Remember that the eight binary 

values in the octet have a base of 2 and from left to right look like 128, 64, 32, 16, 8, 4, 

2 and 1. 

Decimal representation Binary representation 

192 11000000 

168  

10  

255  

2  

 

IPv 4 addresses will be converted in the same way as described above. Fill in the 

table below with the binary equivalents of the addresses provided. To make your 

answers easier to understand, separate the binary octets with dots. 

Decimal representation Binary representation 

192.168.10.10 11000000.10101000.00001010.00001010 

209.165.200.229  

172.16.18.183  

10.86.252.17  

255.255.255.128  

255.255.192.0  

 

Using bitwise operation I to determine network addresses 

the available node addresses using bitwise operation I. You must first convert the 

decimal IPv4 address and subnet mask to their binary equivalent. Having received the 

network address in binary format, we will convert it to decimal. When using operation 

I, the decimal value in each bit position of the 32-bit IP address of the node is 

compared with the corresponding position in the 32-bit subnet mask.  
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If there are two zeros or 0 and 1, the result of operation I will be 0. If there are 

two units, the result will be 1, as shown in the example. 

Example. Determine how many bits should be used to calculate the network 

address. 

Description 

Decimal 

representation Binary representation 

IP address a 192.168.10.131 11000000.10101000.00001010.10000011 

Subnet 

mask 255.255.255.192 11111111.11111111.11111111.11000000 

Network 

address 192.168.10.128 11000000.10101000.00001010.10000000 

 

 To calculate the network address, bits are used, which in the binary mask of the 

subnet have a value of 1. In the above example, 26 bits are used to calculate the 

network address. Enter the missing information in the table below: 

  

 

 

 

 

 

 

 

 

 

 

  

Description 

Decimal 

representation Binary representation 

IP address a 172.16.145.29  

Subnet mask 255.255.0.0  

Network address   

 

   

 Description 

Decimal 

representation Binary representation 

IP address a 192.168.10.10  

Subnet mask 255.255.255.0  

Network address   
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Perform operation AND to determine the network address. 

Enter the missing information in the table below: 

Description 

Dozens 

representation Binary representation 

IP address a 192.168.68.210  

Subnet mask 255.255.255.128  

Network address   

 

   

Description 

     Dozens 

representation Binary representation 

IP address a 172.16.188.15  

Subnet mask 255.255.240.0  

Network address   

 

You have to calculate the network address for the specified IP address and subnet 

masks. After receiving the network address, write down the answers needed to perform 

this laboratory work. 

 

Determine if the IP addresses are on the same network. 

Set up two PCs for the network. The PC-A computer is assigned the IP address 

192.168.1.18, and the PC-B computer is assigned the IP address 192.168.1.33. The 

subnet mask of both computers is 255.255.255.240. 

What is the network address of the PC-A? ___________________________ 

What is the network address in PC-B? ___________________________ 

Will these PCs be able to interact with each other directly? _______ 

What is the largest address assigned to a PC-B computer that will allow it to be 

on the same network as the PC-A? ___________________________ 
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Determine if the IP addresses are on the same network. 

Set up two PCs for the network. The PC-A computer is assigned an IP address of 

10.0.0.16, and the PC-B computer is assigned an IP address of 10.1.14.68. The subnet 

mask of both computers is 255.254.0.0. 

What is the network address of the PC-A? __________________________ 

What is the network address in PC-B? __________________________ 

Will these PCs be able to interact with each other directly? ______ 

What is the smallest address assigned to a PC-B computer that will allow it to be 

on the same network as the PC-A? ____________ 

 

Set default gateway address  

Your company has a policy of using the first IP address on the network as the 

default gateway address. The node in the local network has an IP address of 

172.16.140.24 and a subnet mask of 255.255.192.0. 

What is the network address on this network? __________________ 

What is the default gateway address for this host? ___________ 

 

Set default gateway address  

Your company has a policy of using the first IP address on the network as the 

default gateway address. You have been instructed to configure a new server with an 

IP address of 192.168.184.227 and a subnet mask of 255.255.255.248. 

What is the network address on this network? ___________ 

What will be the default gateway for this server? ___________________ 

 

Classification IPv 4 -address 

You have to identify and classify several examples of IPv4 addresses. 

Analyze the table below and determine the type of address (network address, 

host, multicast or broadcast). 

The first line shows an example of completing the table. 
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IP address a Subnet mask Address type 

10.1.1.1 255.255.255.252 node 

192.168.33.63 255.255.255.192 broadcast  

239.192.1.100 255.252.0.0 multicast 

172.25.12.52 255.255.255.0  

10.255.0.0 255.0.0.0  

172.16.128.48 255.255.255.240  

209.165.202.159 255.255.255.224  

172.16.0.255 255.255.0.0  

224.10.1.11 255.255.255.0  

 

Analyze the table below and determine the type of address –  public or private. 

 

IP address a / prefix Public or private 

209.165.201.30/27 Public 

192.168.255.253/24 Private 

10.100.11.103/16  

172.30.1.100/28  

192.31.7.11/24  

172.20.18.150/22  

128.107.10.1/16  

192.135.250.10/24  

64.104.0.11/16  
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Calculation of IPv4 subnets 

Ability to work with IPv 4 subnets and determine information about networks and 

nodes based on known IP addresses and subnet masks is required to understand the 

principles of IPv 4 networks. You have to calculate the IP address of the network 

based on the known IP address and subnet mask. 

Knowing the IP address and subnet mask, we can set the following subnet data: 

 networks to address y; 

 broadcast in address y; 

 total number of bits of nodes; 

 number of nodes in the subnet; 

Define for the specified IP address and subnet mask:  

 networks to addresses in this subnet; 

 broadcast to addresses in this subnet; 

 the range of node addresses for this subnet; 

 number of created subnets; 

 k number of nodes for each subnet. 

To determine the network address, you must perform binary operation I for IPv4 

addresses, using the specified subnet mask. As a result, we get a network address. If 

the subnet mask has a decimal value of 255 in the octet, the result will ALWAYS be 

the initial value of that octet. If the subnet mask has a decimal value of 0 in the octet, 

the result for this octet will ALWAYS be 0. 

 

Example. 

  IP Address           192.168.10.10 

  Subnet mask       255.255.255.0 

  ======================= 

  Result (network) 192.168.10.0 

Knowing this, you can perform binary operation AND only for the octet whose 

value in the subnet mask is different from 255 or 0. 
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Example. 

  IP Address     172.30.239.145  

  Subnet mask  255.255.192.0 

Analyzing this example, we see that the binary operation AND is required only 

for the third octet. In this subnet mask, the first two octets will give a result of 172.30, 

and the fourth - 0. 

  IP Address      172.30.239.145  

  Subnet mask   255.255.192.0 

  ====================== 

  Result (network)  172 .30.?. 0 

Perform binary operation AND for the third octet. 

    DecimalBinary 

                           239 11101111 

                            192 11000000 

   ======= 

                The result is 192,100,000 

Analysis of this example will again give the following result: 

                        

                      IP Address          172.30.239.145  

  Subnet mask      255.255.192.0 

           ========================== 

  Result (network)  172.30.192.0 

You can calculate the number of nodes for each network in this example by 

analyzing the subnet mask. The subnet mask will be presented in decimal format with 

a semicolon, for example 255.255.192.0, or in the format of a network prefix, for 

example / 18. The IPv4 address always contains 32 bits. Subtracting the number of bits 

used by the network part (as shown in the subnet mask), you get the number of bits 

used for the nodes. 
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In our example, the subnet mask 255.255.192.0 is equal to / 18 in the prefix entry. 

Subtracting 18 bits from 32 bits will give us the remaining 14 bits for the node. 

Based on this, we can perform a simple calculation: 

  2 ^ ( number of node bits) - 2 = number of nodes 

  2 ^ 14 - 2 = 16 382 nodes 

Determine the network and broadcast addresses and the number of node bits for 

the IPv4 address and prefixes listed in the table below. 

IPv4 address / 

prefix 

Network 

address 

Broadcast 

address 

The total 

number of 

node bits 

Total number 

of nodes 

192.168.100.25/28 192.168.100.16 192.168.100.31 4 14 

172.30.10.130/30     

10.1.113.75/19     

198.133.219.250/24     

128.107.14.191/22     

172.16.104.99/27     

 

Subnet calculators 

Understanding the principles of converting a decimal IP address to binary format 

and using operation AND to determine the network address is important, but the 

procedure itself is a time consuming process with a high probability of error.  

To simplify calculations, many network administrators use calculators for IP 

subnets. There are a number of similar programs that can be downloaded and installed 

or run directly from the Internet. 

 In the Application field, enter 192.168.50.50/27 and click Calc! (Calculate). 

Below is a table with information about the network in decimal and binary formats. 
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In this case: network address 192.168.50.32; subnet mask 255.255.255.224; the 

network supports 30 nodes; the smallest node address 192.168.50.33; the largest 

address of the node 192.168.50.62; broadcast address 192.168.50.63. 

 

Calculation of network data using a subnet calculator 

Fill in the tables using the web subnet calculator at http://jodies.de/ipcalc 

1. Fill in the table below for address 10.223.23.136/10. 

 

Description Decimal representation Binary representation 

Address     10.223.23.136  

Subnet mask   

Network address   

Broadcast address   

Address of the first 

node   

Address of the last node   

Number of available 

nodes          Not available 

 

Public or private address type? _____________ 

http://jodies.de/ipcalc
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Report requirements for laboratory work 4 

The report should include: title page, progress with screenshots of tasks and 

performed calculations (this section consists of a sequential description of the 

performed calculations (indicating their essence) and conclusions. 

 

Questions for self-assessment 

1. What is the advantage of programs and web calculators for calculating 

subnets? 

2. What is the role in determining the network address of the subnet mask? 

3. Why should you continue to study IPv4 addressing if the available IPv4 

address space is exhausted? 

4.      What is the importance of the subnet mask when analyzing IPv 4 addresses? 

5.    What rules do you know for determining the network address of a node, 

determining the number of subnets and nodes by mask? 

6.     How can уou determine the address of the first and last node, broadcast 

address? 
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